IBM Tivoli Monitoring for Virtual Environments
Beta Drop 3, October 2012

This document contains late breaking information about this version of the Virtual Environments Beta code. Because this is early beta level code, the product documentation, code, and online help contain inconsistencies about function and nomenclature. This document attempts to clarify what to expect in this version.

Read this document prior to installing this version of the Beta code.

References in content to IBM products, software, programs, services or associated technologies do not imply that they will be available in all countries in which IBM operates. Content, including any plans contained in content, may change at any time at IBM's sole discretion, based on market opportunities or other factors, and is not intended to be a commitment to future content, including product or feature availability, in any way. Statements regarding IBM's future direction or intent are subject to change or withdrawal without notice and represent goals and objectives only. Please refer to the developerWorks terms of use for more information.
Contents:

1.0 New Functions Available in this Beta

2.0 General Image and Installation Information

3.0 Installing the Citrix XenServer agent

4.0 Installing the Citrix XenApp agent

5.0 Installing and configuring the Virtualization Dashboard for VMware

6.0 Installing and Configuring Capacity Planner for VMware

7.0 Installing and Configuring Capacity Planner for PowerVM

8.0 Installing Capacity Planner Reports

9.0 Using the New Functions in the PowerVM Capacity Planner

10.0 Using the New Functions of VMWare Capacity Planner

11.0 Limitations

12.0 Known Issues

Appendix A ITM Attribute Groups for PowerVM warehousing and summarization

Appendix B Configuring Federation Steps

14.0 Notices
1.0 New Functions Available in this Beta

The following key functions are provided in this version of the Beta code:

- **Cisco UCS Agent** -- See the updated Cisco UCS agent user's guide for information on changes to the agent. Documents updated for this Beta can be downloaded from the Beta site. The documentation for version 7.1 can be found online: [http://pic.dhe.ibm.com/infocenter/tivihelp/v15r1/topic/com.ibm.tivoli.itmvs.doc_7.1/cisco/fac_aboutthisdoc.html](http://pic.dhe.ibm.com/infocenter/tivihelp/v15r1/topic/com.ibm.tivoli.itmvs.doc_7.1/cisco/fac_aboutthisdoc.html)

- **VMware VI Agent** -- See the updated VMware VI agent user's guide for information on changes to the agent. Documents updated for this Beta can be downloaded from the Beta site. The documentation for version 7.1 can be found online: [http://pic.dhe.ibm.com/infocenter/tivihelp/v15r1/topic/com.ibm.tivoli.itmvs.doc_7.1/vmware/fac_aboutthisdoc.html](http://pic.dhe.ibm.com/infocenter/tivihelp/v15r1/topic/com.ibm.tivoli.itmvs.doc_7.1/vmware/fac_aboutthisdoc.html)


  - Citrix XenApp remote farm monitoring support for XenApp 6.0 and XenApp 6.5
  - Support for Citrix XenApp 5
  - Support for Citrix License Server monitoring if it is present on the agent machine
  - The Citrix XenApp agent 7.1 Tivoli Common Reporting reports package is included in `<Media Root>\ITMfVE_XenServer_Reports\KXI`


- **Citrix XenDesktop Agent** -- See the updated Citrix XenDesktop agent user's guide for information:
- **VMware Capacity Planner** – The following new content is being delivered for VMware Capacity Planner:
  - Federation Automation for homogeneous federation to TDW on DB2
    - Automated shell/bat scripts for setting up federation between Capacity Planner DB and TDW (on DB2) included in the Capacity Planner database installer package.
  - Enhanced automation for heterogeneous federation to TDW on Oracle and MySQL

  Note: Currently heterogeneous federation needs to be setup manually following the documented steps in Appendix B.
  - DB2 10.1 support

- Additional workload analysis report for VMware – A new report to compute and visualize details of additional workloads that can be accommodated in the environment if recommended plan is implemented. This report supports virtualization overhead.
- Support for loading configuration data incrementally - Earlier the capacity planner load configuration loaded all the available data with ITM and would overwrite the contents in the Capacity Planner database. With the incremental data load, the configuration table columns in capacity planning are refreshed when the corresponding data on VMware VI agent changes.
- Federation configuration setup for heterogeneous federation is enhanced and automated significantly saving database administrator's time improving the Time To Value. The automated heterogeneous federation is available for Oracle and MySQL databases.
- Actionable Recommendation Report- Report that highlights actionable task post optimization on the optimized report such as movement of VMs across clusters, VMs that could not be placed etc.

- **PowerVM Capacity Planner** – The following new content is being delivered for Power Capacity Planner:
  - Support for Capacity planning in PowerVM environment includes loading of configuration data and modification UI and reports for PowerVM terminology.
  - LPAR Sizing based on utilization data using WLE basic flow - user can select sizing action which will launch WLE and then take user thru 3 steps to generate sizing output. Please see “known issues” list for limitations of this functionality in beta-2
  - Sizing and Inventory Reports
  - **Support for loading configuration data in an iterative manner**. Previously the capacity planner load configuration loaded all the available data with ITM populate the contents in the Capacity Planner database. With the iterative data load, it is possible to iteratively load selected data from ITM.
• **Federation configuration setup for heterogeneous federation is enhanced** and automated significantly saving database administrator's time resulting in Time to Value improvement. The automated heterogeneous federation for PowerVM is available for the Oracle database.

• **Five Step process in Planning Center** – Planning center workflow from data load to inventory views/reports for PowerVM. Steps to perform the compute usage action and launch the sizing engine to calculate the required LPAR sizes are also available.

• **Ability to size LPARs for retired power systems.** With this enhancement, it is possible to size LPARs for retired system using the “Existing system” option.

• **New Power VM Recommended Environment Report** – A new report that summarizes and shows the current and recommended allocations for LPARs is available.

### 2.0 General Image and Installation Information

There is no upgrade support between beta drops. Previous Beta installations, including the IBM Tivoli Monitoring components (for example, databases used by IBM Tivoli Monitoring), must be completely uninstalled to ensure a fresh environment.

• **Capacity Planner, VMware Dashboard, and Reports Image**
  - Capacity Planner (VMware and PowerVM), VMware Dashboard, and Reports (VMware agent and Linux KVM agent) are included in a single image itmfve_dashboard_<ID>.tar.gz
  - Extract (itmfve_dashboard_201210070836.tar.gz) ITMfVE 7.2 Build image to a temporary folder, for example C:\beta3.
  - Installer repository is part of ITMfVE 7.2 build image: The extracted file contents will look like the following:

  - **IBM Repositories**
    - **prop_file**
      - 10/7/2012 12:45 AM File folder
    - **Unix**
      - 10/7/2012 12:44 AM File folder
    - **Windows**
      - 10/7/2012 12:45 AM File folder

• **Capacity Planner Install and Deploy** –
  - Starting with this Beta, Capacity planner (for VMware and PowerVM) is being installed using the IBM Installation Manager 1.6.
  - Capacity Planner (for VMware and PowerVM) will now support TIP 3.1
  - Capacity Planner is deployed as a separate application for each hypervisor. This enables users to install each application separately and use them concurrently for independent recommendation for each hypervisor.

  - **Note:** Please see **Capacity Planner Limitation** section in this document. Due to an existing defect in this Beta image, Capacity
Planner for VMware and PowerVM must be installed in separate TIP 3.1 environment.

- **Virtualization Dashboard Install and Deploy** –
  - VMware Dashboard continues to be installed using InstallAnywhere.
  - VMware Dashboard will continue to support TIP 2.2.0.7.
  - VMware Dashboard installation files are in the $ITMfVSDash$ subdirectory under *Unix* and *Windows* directories depending on the platform.
  - See the Dashboard, Reporting, and Capacity Planning User's Guide for further information on installation:

- **Virtualization Reports Install and Deploy** –
  - The Capacity Planner reports (for VMware and PowerVM) as well as VMware and Linux KVM Reports continue to be installed using InstallAnywhere.
  - All the reports can be deployed in TCR 2.1.1 and TCR 3.1.
  - Reports installation files are in the *reports* subdirectory under *Unix* and *Windows* directories depending on the platform.
  - See 8.0 Installing Capacity Planner Reports
  - See the Dashboard, Reporting, and Capacity Planning User's Guide for further information on installation:

In general, install the ITM for Virtual Environments components in the following order:

1. Install agents into IBM Tivoli Monitoring and ensure that you are able to see information about your VMware environment in the Tivoli Enterprise Portal. Individual Agent User’s guide should be referenced to install and configure the agents. Any changes or special instructions to an Agent installation will be covered in a marked section below.

2. Install Tivoli Common Reporting V2.1.1. This software provides both the Tivoli Integrated Portal V2.2 environment needed for the dashboard and the reporting infrastructure for the VMware and capacity reports.

3. Install the required Tivoli Integrated Portal 2.2.0.7 update (see the Prerequisites section of See section 5.0 Installing and Configuring the Virtualization Dashboard for VMware below).

4. Install and configure the Virtualization Dashboard (VMware Dashboard) into Tivoli Integrated Portal V2.2. See section 5.0 Installing and Configuring the Virtualization Dashboard for VMware below.

5. Install VMware and PowerVM Capacity Planner. See section 6.0 Installing and Configuring Capacity Planner for VMware and section 7.0 Installing and Configuring Capacity Planner for PowerVM below for prerequisites and details to install VMware and PowerVM Capacity Planner.
6. Install the Tivoli Common Reporting reports (Agent Reports and Capacity Planner Reports) using the report installer. See section 8.0 Installing Capacity Planner Reports below.

3.0 Installing the Citrix XenServer agent

The XenServer agent installation media for this beta release is contained within the XenApp agent download file. Future beta releases will provide the XenServer agent installation media in a separate download file. After downloading and unpacking the XenApp agent file, listing the directory contents will reveal six folders, three folders with XenApp agent content and three folders with XenServer agent content.

- ITMfVE_XenApp_Agent/
- ITMfVE_XenApp_Application_Support/
- ITMfVE_XenApp_Reports/
- ITMfVE_XenServer_Agent/
- ITMfVE_XenServer_Application_Support/
- ITMfVE_XenServer_Reports/

4.0 Installing the Citrix XenApp agent

Prerequisites

The prerequisites for the Citrix XenApp 7.2 agent can be found at
- In addition to the prerequisites for the Citrix XenApp agent, the following prerequisites must be met for the Citrix XenApp remote farm monitoring functionality
  - The Server the agent is installed on and the remote monitored Citrix XenApp Servers must be a part of the same domain. The domain account needs to have administrator privileges.
  - Powershell remoting must be enabled on the Servers that the agent is installed on and the Servers being monitored. Running the following commands can enable Remoting.
    - Enable-PsRemoting
    - Set-Item WSMAN:\localhost\Client\trustedhost <host> -force –concatenate
  - Running the following command can test Remoting.
    - Invoke-command -computername <host> -command {<any-powersh

Procedure
Extract the agent installation media from the IBM Tivoli Monitoring for Virtual Environments for Citrix XenApp image.
From the WINDOWS directory where the agent package was extracted launch the installer by running setup.exe
After the GUI installer launches, follow the prompts on the screen.

1. Click **Next** on the welcome screen.
2. Accept the license agreement
3. Select the destination folder where setup will install files
4. Select the features you want to install, and deselect the features you do not want to install
5. Review setting before installation begins
6. Select the setup type that suits your needs
7. Configure defaults for connecting to a TEMS
8. Configure the Monitoring agent for Citrix XenApp remote farm monitoring. Set default credentials used for all remote XenApp connections
   a. Enter the domain and the username (Example: yourDomain\yourUsername)
   b. Enter the password for the username specified.
9. Enter the name of one Server per farm being monitored.
10. Click **OK** and wait for the installer to finish.

### 5.0 Installing and configuring the Virtualization Dashboard for VMware

**Installing the Virtualization Dashboard for VMware**

**Prerequisites:**

The Virtualization Dashboard requires
- Tivoli Integrated Portal V2.2.0.7 (see **Required Updates** section below)
- DB2 v9.1 or later (Note: Customers can download a trial version of DB2 10.1 via IBM Tivoli Monitoring Beta site.)
- IBM Tivoli Monitoring v 6.2.2 FP4 or later
- IBM Tivoli Monitoring for Virtual Environments Agent code
- Tivoli Common Reporting v2.1.1

**Required Updates**

The following update that must be manually applied to the Tivoli Integrated Portal V2.2 installation for proper operation:
- TIP 2.2.0.7 (including FixPack Readme) – to be downloaded from FixCentral from the link below:
Configuring the Virtualization Dashboard for VMware

Configure Virtualization Dashboard to refer to the Tivoli Enterprise Portal Server in your IBM Tivoli Monitoring environment. You can optionally configure the dashboard to connect to your Tivoli Application Dependency Discovery Manager (TADDM) V7.2 or later server. Instructions for installing and configuring the dashboard are in the V7.1 of Dashboard, Reporting, and Capacity Planning User's Guide:

6.0 Installing and Configuring Capacity Planner for VMware

Installing VMware Capacity Planner

Before you begin

- Install IBM Installation Manager 1.6.
- Install the Jazz for Service Management 1.1 driver Milestone 7 or later. You must select the following Jazz for SM components that are required for VMware Capacity Planner:
  - Web Sphere Application Server 8.5
  - JazzSM Extension to Web Sphere Application Server 8.5
  - Tivoli Integrated Portal 3.1
- For Capacity Planner Database, you must create an empty database for both the local and remote installations.
For example,

db2 create database TADFDCDB USING CODESET UTF-8 TERRITORY US COLLATE USING SYSTEM
**Note:** It is required that the Capacity Planner database should get created using the db2 instance owner. The instance owner on the Linux and UNIX operating systems is “db2inst1”; and on the Windows operating system, the instance owner is “db2admin”. Failures might be observed in Post Install Federation step if you try to create Capacity Planner database with a user with non-compliant authorization levels.

**About this task**

This task provides information about installing VMware Capacity Planner on Tivoli Integrated Portal 3.1.

**Procedure:**

**On Windows**

On the Windows operating system, complete the following steps:

1. Open the IBM Installation Manager.
2. Click on File -> Preferences. Click on Add Repository to select the repository.config file that is available in the installer, and then click OK.

3. Click Install.
4. On the Install Packages page, select the **VMware Capacity Planner** check box, and then click **Next**.

**Note:** When you select the **VMware Capacity Planner** check box, the installer automatically selects the version of the VMware Capacity Planner.
The Install Packages page displays the package group and the location of installed Tivoli Integrated Portal where the VMware Capacity Planner will be installed.

5. Click Next.
6. Select the Configuration check box, and then click Next.
7. Enter the WebSphere Application Server credentials, and then click Validate.
8. After the credentials are validated, click Next.
9. Enter the Capacity Planner Database details for Capacity Planner Database Schema creation, and then click **Validate**.

10. After the credentials are validated, click **Next**.
11. The summary page displays the details of the components that will be installed. If all the details are correct, click **Install**.
12. After the installation is completed, click **Finish**.

**Note:** After the installation is completed, you can refer to the log files that are available at the following location:
<Installed JazzSM location>/installedDashboards/com.ibm.tivoli.cpdash/logs/installer-logs-${timestamp}.zip
ON Linux
On the Linux operating system, complete the following steps:

1. Open the IBM Installation Manager.
2. On the Preferences page, select the repository.config file that is available in the installer, and then click OK.
3. Click Install.
4. On the Install Packages page, select the **VMware Capacity Planner** check box, and then click **Next**.

   **Note:** When you select the **VMware Capacity Planner** check box, the installer automatically selects the version of the VMware Capacity Planner.
The Install Packages page displays the package group and the location of installed Tivoli Integrated Portal where the VMware Capacity Planner will be installed.

5. Click Next.

6. Select the **Configuration** check box, and then click Next.
7. Enter the WebSphere Application Server credentials, and then click **Validate**.
8. After the credentials are validated, click **Next**.
9. Enter the Capacity Planner Database details for Capacity Planner Database Schema creation, and then click Validate.

10. After the credentials are validated, click Next.
11. The summary page displays the details of the components that will be installed. If all the details are correct, click Install.
12. After the installation is completed, click Finish.

**Note:** After the installation is completed, you can refer the log files that are available at the following location:
Installed JazzSM location/installedDashboards/com.ibm.tivoli.cpdash/logs/installer-logs-${timestamp}.zip

**Results:**
The VMware Capacity Planner is installed on Tivoli Integrated Portal 3.1.

**Configuring VMware Capacity Planner**

To configure VMware Capacity Planner, complete the following steps:

1. Modify the following files in the VMware Capacity Planner installation directory:
   i. database.properties
      Enter the values in the following fields for Capacity Planner database:
      - server
      - port
      - username
ii. dmstore.cfg
   Modify the value of \texttt{DB\_CONFIG\_SOURCE} to \texttt{file}.
   For example,
   \texttt{DB\_CONFIG\_SOURCE=file}

iii. dmloader.cfg
   a. Uncomment \texttt{DMLOADER\_CONFIG\_FROM\_FILE} and set the value to \texttt{1}.
      For example,
      \texttt{DMLOADER\_CONFIG\_FROM\_FILE=1}
   b. Provide IBM Tivoli Monitoring Data Provider details by un-commenting
      and setting values for \texttt{ITMDP\_HOST}, \texttt{ITMDP\_PORT}, \texttt{ITMDP\_BASE\_URL},
      \texttt{ITMDP\_USER}, \texttt{ITMDP\_PASSWORD}, and
      \texttt{ITMDP\_DATAPROVIDER\_MODE}.
      \textbf{Note}: The fields cannot be blank.
   c. Provide Capacity Planner Datamart database server details by un-
      commenting and setting values for \texttt{DATAMART\_DB\_TYPE},
      \texttt{DATAMART\_DB\_DRIVER}, \texttt{DATAMART\_DB\_HOST},
      \texttt{DATAMART\_DB\_PORT}, \texttt{DATAMART\_DB\_NAME},
      \texttt{DATAMART\_SCHEMA\_NAME}, \texttt{DATAMART\_USER}, and
      \texttt{DATAMART\_PASSWORD}.

iv. kbloader.cfg
   a. Uncomment \texttt{KBLOADER\_CONFIG\_FROM\_FILE} and set the value to \texttt{1}.
      For example,
      \texttt{KBLOADER\_CONFIG\_FROM\_FILE=1}
   b. Provide Capacity planner Datamart database server details by un-
      commenting and setting values for \texttt{DATAMART\_DB\_TYPE},
      \texttt{DATAMART\_DB\_DRIVER}, \texttt{DATAMART\_DB\_HOST},
      \texttt{DATAMART\_DB\_PORT}, \texttt{DATAMART\_DB\_NAME},
      \texttt{DATAMART\_SCHEMA\_NAME}, \texttt{DATAMART\_USER}, and
      \texttt{DATAMART\_PASSWORD}.

The files that you must modify to configure VMware Capacity Planner are
available in the following Tivoli Integrated Portal installation directory:

<installation\_location>/JazzSM/profiles/installedApps/<TIP\_CELL\_NAME>/isc.
ear/AnalyticsWebUI.war/WEB-INF/classes

For example,
   - On windows operating system, the following is location of files:
C:\Program Files\IBM\JazzSM\profiles\installedApps\TIPNodeCell\isc.ear\AnalyticsWebUI.war\WEB-INF\classes

- On non-windows operating systems, the following is the location of files: /opt/IBM/JazzSM/profiles/installedApps/localhostNode01Cell/isc.ear/AnalyticsWebUI.war/WEB-INF/classes

2. Restart the Tivoli Integrated Portal.

7.0 Installing and Configuring Capacity Planner for PowerVM

Before you begin

- Install IBM Installation Manager 1.6.
- Install the Jazz for Service Management 1.1 driver Milestone 7 or later. You must select the following Jazz for SM components that are required for VMware Capacity Planner:
  - Web Sphere Application Server 8.5
  - JazzSM Extension to Web Sphere Application Server 8.5
  - Tivoli Integrated Portal 3.1

Note: Do not install Administration, Registry and Security services that are bundled as part of OSDP driver 16 / 17. Capacity Planner for PowerVM doesn't require this and the installation may fail if we enable these services.

- Select the 64-bit version of TIP 3.1 package.
- For both the local and remote installations of Capacity Planner Database, you must create an empty database as shown in the example below:

  db2 create database TADFDCDB USING CODESET IBM-1252 TERRITORY US COLLATE USING SYSTEM PAGESIZE 16384

Note: You must create the Capacity Planner database as the db2 instance owner. The instance owner on the Linux and UNIX operating systems is “db2inst1”; and on the Windows operating system, the instance owner is “db2admin”. The Post Install Federation step might fail if the Capacity Planner database is created as a user with non-compliant authorization levels.

Installation Sequence:
1. Start IBM Installation Manager & navigate to File → Preferences. On the Preferences page, click on Add Repository to select the repository.config file for PowerVM Capacity Planner that is available in the installer, and then click OK.

   For example
   C:\beta3\IIM Repositories\PowerVM Capacity Planner\repository.config,

2. Select the Capacity Planner for PowerVM Package as shown here:

3. Select the package group: Specify Existing package group as shown in figure below:

4. Select the package group: specify existing package group as shown in figure below:
5. Select the default Installation and Configuration Option.

6. Specify TIP 3.1 WAS credentials and enter Validate:
7. After successful TIP User validation click next:

8. Provide Capacity Planner for PowerVM Database Details as shown here:
9. To open the Main Installation window, click Validate and then click Next.

To start the installation process, click Install.

10. View Installation Progress:
Installation process runs for around 15 minutes.
- Installation status will be shown on the progress bar.
- See the window that tells you you have successfully completed the installation.
- To complete the installation process, click Finish.

Post Installation Configuration Steps:

**Step 1**: To verify the installation is successful, click File → View Installed Packages from IIM.
Step 2: Log on to the IBM Dashboard Application services Hub to verify that you can start the Planning Center for PowerVM
**Step 3:** Edit the following configuration files:

$TIPPATH/profiles/installedApps/localhostNode01Cell/isc.ea r/AnalyticsWebUIPower.wa r/WEB-INF/classes directory:

database.properties
   Enter the values in the following fields for Capacity Planner database:
   - server
   - port
   - username
   - password
   - db
   - schema

systemloader.cfg
   Provide ITM Data Provider details by setting the following values
   - ITMDP.HOST
   - ITMDP.PORT
   - ITMDP.BASE_URL
   - ITMDP.USER
   - ITMDP.PASSWORD
   **Note:** You must enter a value into these fields

   Provide Capacity Planner database server details by setting the following values:
   - DATAMART.DB_TYPE
   - DATAMART.DB_DRIVER
   - DATAMART.DB_HOST
   - DATAMART.DB_PORT
   - DATAMART.DB_NAME
   - DATAMART.SCHEMA_NAME
   - DATAMART.USER
   - DATAMART.PASSWORD.

**Step 4:** Restart the TIP Server.

**Configuring Capacity Planner PowerVM Federation Steps:**

Database Federation scripts for PowerVM are packaged as part of the installer and are copied to the installed directory in the following paths
- **On Linux:**
  /opt/IBM/JazzSM/installedDashboards/com.ibm.tivoli.cppowervm/AnalyticsData baseInstaller/federation_power
- **On Windows:**
Before you begin

- Install Tivoli Common Reporting 3.1.
- Extract the reports package from the IBM Tivoli Monitoring for Virtual Environments image.
- Enable historical collection and summarization and pruning for the attribute groups.

Note: On the non-Windows operating systems, you might need to point to Java 1.6+ through your system PATH. Make sure that your system PATH contains a valid path to a Java Virtual Machine. For example,

    # PATH=$PATH:/ibmjre60/ibm-java-i386-60/jre/bin

Procedure

To install the Capacity Planner Reports, complete the following steps:

1. In the directory where you have extracted the reports package, double-click reports.
2. Run the installer that matches your operating system.
On the Windows operating system, run the following installer:
**setup_windows.exe**

On the Linux operating system, run the following installer: **setup_linux.bin**

The following is the syntax to run the installer in the console mode:
```
setup_<platform>.exe/.bin –i console
```

The following is the syntax to run installer in the silent mode:
```
setup_<platform>.exe/.bin –i silent –f <path_to_response_file>
<silent_installer.properties>
```

3. Select a language, and then click **OK**.
4. On the Welcome page, click **Next**.

5. On the Choose Installation Folder page, select the location where the Tivoli Common Reporting server is installed, and then click **Next**.

   **Note:** This is not the location where the reports are to be installed.

   The path must end with /TCRComponent folder. By default, the following is the path for Tivoli Common Reporting, Version 2.1:

   C:\IBM\tivoli\tipv2Components\TCRComponent or /opt/IBM/tivoli/tipv2Components/TCRComponent.

   By default, the following is the path for Tivoli Common Reporting, Version 3.1:

   C:\Program Files\IBM\JazzSM\reporting or /opt/IBM/JazzSM/reporting
6. On the Choose the reports for installation page, select the reports that you want to install, and then click **Next**.
7. On the Cognos Engine Configuration page, enter the user name and password for Tivoli Common Reporting, and then click **Next**.
8. If you have selected any cognos reports, enter COGNOS data sources configuration details, and then click **Next**. 
**Note:** If you have already the defined the TADFDCE_REPORTING_DS data source, complete to the next step.

9. On the Cognos Data Source TDW Configuration page, enter the required details, and then click **Next**.
10. On the Data Script runDbScript Configuration page, enter the required details, and then click **Next**.
11. On the summary page, verify the details, and then click **Install**.
12. The post-installation page shows the status of all installation actions for every item or report.

The log file and trace file are in the user home directory. The following are the names of the files:
   1. Report_Installer_for_Tivoli_Common_Reporting_InstallLog.log (Log)
   2. Report_Installer_For_TCR_Output.txt (Trace).

**Results**
Cognos Reports for IBM Tivoli Monitoring for Virtual Environments are installed on the Tivoli Common Reporting server.

There is no upgrade support between beta drops. Previous Beta installations, including the IBM Tivoli Monitoring components (for example, databases used by IBM Tivoli Monitoring), must be completely uninstalled to ensure a fresh environment. IBM recommends that user create a new database for each installation.

**9.0 Using the New Functions in the PowerVM Capacity Planner**

**Configuration Data - Iterative Load**

It is possible to selectively load managed systems and the LPARs on them to the Capacity Planner database for analysis. This also allows the user to iteratively load the environment in case of

To enable and load configuration data for selected managed systems.
Step 1: After login go to “Planning Center for PowerVM”

![Planning Center for PowerVM](image)

**Step 1: Snapshot config data.**
Load the latest configuration data for managed systems and logical partitions for analysis. You can change this data for what-if analysis.

Advanced options:
Select the data load options.

* Iterative Data Load

**Step 2:** On "Planning Center for PowerVM" page select/enable the "Iterative Data Load" checkbox.
Step 3: After enabling “Iterative Data load” checkbox click on “Load Config” Button below it. This should bring up the popup with listing of available managed systems in the environment. Here the user can see list of managed systems in left hand side.

**Note:** To get the list of Managed systems in the UI, it is required to have the ITM configured to collect data from the HMC that is managing these systems and also the correct configuration is defined in the systemloader.cfg file as mentioned ‘Post Install Configuration Steps’ section.

![Selective data load](image)

Step 4: From the available managed systems user can filter desired managed systems using the filter input box. Once desired systems are shown in left hand side list, select managed system for which configuration data is to be loaded in Capacity Planner database and click on “Add >” button. For all managed systems, click on “Add All >” button. This should move selected managed systems to right hand side list.

Step 5: After list of selected managed system is prepared on right hand side click on “Ok” button. This will trigger the loader to load configuration data of selected managed systems and LPARs on those managed systems.

Step 6: After loading is complete following message box will appear
User can click on “Edit Current Environment” link to go to environment page to see/edit loaded managed systems.

Note:

- If “Load Config” button is clicked without enabling “iterative load” checkbox then loader will attempt to load all managed systems and their LPARs after erasing all earlier information about managed systems and LPARs which was loaded earlier. Information which is erased in this case includes tag information, working set scope, source and target tags of managed systems and computed/edited usage for LPARs.
- If “Iterative Data load” is enabled and any managed system which was loaded in earlier iterations is selected again in this iteration then only its configuration information of that managed system and its LPARs (such as host name, entitlement etc) will be overwritten. All tag information and LPARs utilization information will not be erased or overwritten.
- Configuration data, scope data, tags information, computed/edited usage data of managed systems and their LPARs which were loaded earlier and are not selected for this iteration will remain unchanged and untouched.
**Five Step process including Compute Usage**

The Capacity Planner for PowerVM is a five step process.

Step 4: Analyze logical partition characteristics invokes the “Compute Usage” action which analyzes the warehouse data. Clicking the “Size LPARs” button will compute the usage as per the warehouse data.

Note that unlike the earlier release, this step no longer launches the sizing engine (which is invoked in the next step).

Step 5: Generate optimization plan.
This step launches the sizing engine in a new tab. Sizing of the partitions is done using this sizing engine. Once the sizing is complete, you can invoke the “Optimized plan report” link which will launch the Recommended Environment Report.

---

**Ability to size LPARs for retired Power Systems**
With this code drop, it is possible for the sizing engine to size Power Systems which have been deemed retired for the “Size on existing systems” option.

As an example the 550-8204-E8A is a retired system. It is possible to size LPARs on such systems.

### PowerVM Sizing Recommendation Report:

The PowerVM Sizing Recommendation Report is a new report which ships with the product. Once the sizing of LPARs is done after step 5, a summary of the recommendations is shown on the screen as shown. You can launch the PowerVM Recommended Environment Report from this page.

**Selected system**

**Choose Baseline System**

- Make one selection below for your existing system. The sizing engine will recommend a solution based on your selection.
- Select the existing system option to give preference to this base model.
- For consideration of typical migration paths, select the migration path option.
- The final selection in the list below allows the system selection algorithms to choose the best system without consideration of any migration or upgrade paths.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Existing System Model</td>
<td>Size #550-8204-E8A (4200 MHz, 1.6GB, 15900 CPW, 41.4 Gbps) recommended</td>
</tr>
<tr>
<td>Choose a new model based on typical migration paths if possible (default selection)</td>
<td></td>
</tr>
<tr>
<td>Allow the system selection algorithms to choose the best system without giving any preference based on existing system migration or upgrade paths</td>
<td></td>
</tr>
</tbody>
</table>

Note: In the earlier drop, this option would either show an asterisk or always choose a newer system while sizing LPARs.
The PowerVM Recommended Environment Report shows the current and recommended CPU and memory entitlements for each of the LPARs for the selected physical systems.

The default report includes all the selected physical systems. You can change this and report by choosing the one or more physical systems from the list.

A sample report top level snapshot with two servers is as shown below for reference.
10.0 Using the New Functions of VMWare Capacity Planner

Additional Workload report:
In the growth planning and ROI scenarios, cloud administrator generates an optimization plan to verify how much spare CPU and Memory is left in the defined scope and then how many virtual machines can be fit in the spare. This report shows the number of virtual machines that can be fit in the spare based on the Maximum, Average, Minimum virtual machine profile. The Additional workload report shows how many virtual machines can be fit in the spare based on the Maximum, Average, Minimum virtual machine profile. The default value is Average. The report also shows how the virtual machines are distributed. This distribution is important, for example, Average may not accurately reflect the correct picture. Report takes the values that are entered by the user (based on the virtual machine distribution) to show how many virtual machines can be fit, based on the entered values. This report excludes virtualization overhead in the calculations.

Configuration Data - Incremental Load
The Capacity Planner for VMware uses the IBM Tivoli Monitoring data provider that provides the configuration data for capacity planning. IBM Tivoli Monitoring, Version 6.3, is required for next version of VMware Capacity Planner. The Representational State Transfer (REST) service needs to be enabled on the Tivoli Enterprise Portal Server for this in the IBM Tivoli Monitoring environment.

You can refer installation and configuration instructions to use the IBM Tivoli Monitoring data provider.

By using the Incremental load of configuration data for VMware capacity planner, you can select the Incremental Data Load to refresh the configuration data. The incremental load also makes sure that the user configuration (such as custom tags, edited usage data, and so on) is persisted after the incremental load.

**Actionable Recommendation Report enhancement**

A new section has been added in Capacity Planner Optimized Environment Plan report which highlights the following points as actionable recommendation scenarios:

- VMs moved from one cluster to another
- VM that could not be placed and associated reason(s)
- DCs that has significant change in CEI
- Clusters that has significant change in CEI
- Physical Servers that has significant change in CEI
- VMs that has significant change in PRI
- Summary usage of fictitious servers

Where:
CEI refers to Capacity Efficiency Index and PRI refers to Performance Risk Index.

**11.0 Limitations**

This is an early beta release and there are a number of limitations that you might encounter. The following limitations are some of the most significant:

- Using this Beta image, Capacity Planner for VMware and Capacity Planner for PowerVM cannot be installed in a shared TIP environment and must be installed on separate TIP 3.1 servers.
- Citrix XenApp limitations:
  1. Supported Citrix XenApp versions:
     - XenApp 6.5 (All Editions) Note: Session-host-only installation is not supported.
     - XenApp 6.0 (All Editions)
     - XenApp 5.0 (All Editions)
2. Supported Citrix XenApp agent platforms:
   - XenApp 6.0 and 6.5
     - Windows(R) 2008 R2 x64 (All Editions)
   - XenApp 5.0
     - Windows 2008 x64 (All Editions)
     - Windows 2008 x86 (All Editions)
     - Windows 2003 x64 (All Editions)
     - Windows 2003 x86 (All Editions)

3. If you have two farms with the same name, only one of it will be displayed in the TEP. Two subnodes with the same subnode key cannot be displayed.

4. The Citrix XenApp farm monitoring is supported on all editions of XenApp 6.0 and XenApp 6.5. It is not supported on any edition of XenApp 5.0.

- Power VM Capacity Planner limitations:
  Currently, only the “Recommended Environment Report” is available. The other report links for PowerVM reports will not be functional.

- Power VM and VMware Capacity Planner limitations:

  For Capacity Planner database installed on Unix, federation of Oracle Tivoli Data Warehouse tables is a manual process. The procedure to create wrapper, server, and user mapping is documented in Appendix B.

12.0 Known Issues

Defect 38417: VMware and PowerVM Capacity Planner

**Problem Description:** For IPv6 enabled machines, the JDBC connection to Analytics database might fail because of mapping of localhost to ::1 IP address.

**Workaround:** On the Capacity Planner Database Schema Creation page, enter the Capacity Planner Database Server Host Name as <IPv4 address> instead of local host.

For Example,
Defect 35256: VMware and PowerVM Capacity Planner

**Problem Description:** DBInstaller on the Windows operating system does not work when DB2 is freshly installed and no database is created from DB2 command line/GUI.

**Workaround:** Create SAMPLE database when you install DB2 using GUI mode or create a database using command line before running DBInstaller.

Defect 68726: VMware and PowerVM Capacity Planner

**Problem Description:** After you have installed VMware Capacity Planner, you might see the following warning message on the IBM Installation Manager panel if the Admin and Registry services components of JazzSM were selected during JazzSM installation.

> “Administration Service Task Bundle Registration

Failed to register resource. Returned status:”

In addition, in the log files for IBM Installation Manager, you might see the following warning and error messages:

> “Failed to register resource. Command output: Cannot register the Machine_Name>:16311-oslc resource. Check that the resource details are correct, and use the -registerResource operation to register the resource. CTGPD0004E Cannot run the operation. -registerResource Register a resource with the configuration service provider. Syntax: -registerResource –registerResource <response-file>”

**Workaround:** During JazzSM installation, do not select Admin and Registry services. Select to install the following components as required by the VMware Capacity Planner:

- Web Sphere Application Server 8.5
- JazzSM Extension to Web Sphere Application Server 8.5
- Tivoli Integrated Portal 3.1 of JazzSM

Ignore the warning and error messages in the log files.
Note: VMware Capacity Planner will work irrespective of this problem.

Defect: VMware and PowerVM Capacity Planner

**Problem Description:** For PowerVM sizing, if an LPAR without the required OS and OS Version attributes is selected for sizing, you will see an error as shown when you try to size the systems.

**Workaround:** Add the OS and OS Version manually for the LPAR from the “View” -> “Inventory” -> “Logical Partitions” view of the Edit PowerVM Current Environment Screen.

Defect: VMware and PowerVM Capacity Planner

**Problem Description:** Federation on Windows fails when run from path which has space character in it.

**Reason:** Internally federation scripts call db2 cmd with parameters. Path to federation script is also a parameter. If a parameter to db2cmd has space in it is treated as 2 separate arguments and hence system cannot find the path specified.

**Workaround:** Copy “federation” and “federation_power” directories to path which doesn't have space character in absolute path.

Defect #66414: VMware and PowerVM Capacity Planner

**Problem Description:** tadfdc_setup_fed.sh and tadfdc_setup_fed_mssql.sh stop if view creation failed.

Defect 67432: Capacity Planner for VMware report

**Problem Description:** 'Page up/Page Down' functionality is not working properly for Actionable Reports.

**Workaround:** View the report in PDF format.

Defect 68827: Capacity Planner for VMware report

**Problem Description:** The report “VMs that have significant change in PRI” includes virtual machines that are not part of working set.

**Workaround:** None

Defect 68819: Capacity Planner for PowerVM report
Problem Description: The PowerVM Recommendation Report is not getting exported or running as PDF format. It is getting the almost blank report.

Workaround: None

Defect 192685: VMware VI agent Report

Problem description: In the VMware VI Report Prerequisite Scanner, the Prerequisite tables for Tivoli Common Reporting Shared Dimensions show green status even if the tables do not exist in warehouse database.

Workaround: Check the warehouse whether the following four tables have been created in database to get the correct status:
- TIME_DIMENSION
- WEEKDAY_LOOKUP
- MONTH_LOOKUP
- ComputerSystem

Defect 185240 VMware Dashboard:

Problem Description: Refresh mechanism (using F9 or View->Refresh) on the Server, Network, and Storage diagnostic pages) does not work.

Defect 183468 VMware Dashboard:

Problem Description: Dashboard installation fails when using TCR set up with a remote Cognos server.

Defect 185259 VMware Dashboard:

Problem Description: Guest OS portlet (under Server Details page) does not load data if other details pages (Network or Storage Details) are open.

Troubleshooting Tips:

Observed Behavior: db2 create wrapper net8 command fails with the message “SQL10013N The specified library "libclntsh.so" could not be loaded.

SQLSTATE=42724”

Reason: If Oracle client is installed as a different user, db2inst1 won't have permission to access $ORACLE_HOME/lib folder. Db2 create wrapper net8 will try to load libclntsh.so present in that directory and the operation will fail.

Workaround: Provide access to $ORACLE_HOME folder for user db2inst1

For example: chmod o+rx /home/oracle
Appendix A

*PowerVM Federation: ITM Attribute Groups to be enabled for warehousing and summarization*

<table>
<thead>
<tr>
<th>Attribute Group</th>
<th>Agent</th>
</tr>
</thead>
<tbody>
<tr>
<td>KPK_MON_UNMON_ALLOC</td>
<td>CEC</td>
</tr>
<tr>
<td>KPK_GLOBAL_CEC</td>
<td>CEC</td>
</tr>
<tr>
<td>KPK_MON_LPARS</td>
<td>CEC</td>
</tr>
<tr>
<td>KVA_DISKS</td>
<td>VIOS</td>
</tr>
<tr>
<td>KVA_NETWORK_ADAPTERS_RATES</td>
<td>VIOS</td>
</tr>
<tr>
<td>KVA_NETWORK_MAPPINGS</td>
<td>VIOS</td>
</tr>
<tr>
<td>KVA_STORAGE_MAPPINGS</td>
<td>VIOS</td>
</tr>
</tbody>
</table>
Appendix B

Configuring Federation Steps:

Configuring Homogenous Federation Automation:

As a part of enhancement to logging during automation of federation of homogeneous environment, two log files setup.log and federation.log are now merged into single log file i.e. federation.log.

Federation scripts for PowerVM could be found in
   {dbinstaller_dir}/federation_power directory

Note:
Federation setup for Power VM is currently supported only on UNIX platform

Using fed_admin.sh/bat

fed_admin script can be run in two modes
   (i) non-interactive mode
       In this mode fed_admin script configures the federation server and creates all views for physical server and virtual machine.
   (ii) interactive mode (Run fed_admin.sh/bat with -i argument)
       In this mode user can select operation he wants to perform (Configure new server/ update user mapping/ add views/ delete views)

To get correct result from scripts in any mode, correct input parameters are to be specified in fed_config.cfg file

Other options are :
   -i run script in interactive mode
   -f <custom_config_file_name> : custom_config_file_name is the file with non-default configuration parameters created by user.

When this option is not specified, script will use default config file fed_config.cfg

Steps to run fed_admin.sh/bat script
1. Set all input parameters in configuration file (default configuration file is fed_config.cfg).
2. On command prompt run fed_admin
   (i) ./fed_admin.sh -f <custom_config_file> <JAVA_HOME>
       Configures federation server and creates all views for physical server and virtual machine
   (ii)./fed_admin.sh -i -f <custom_config_file> <JAVA_HOME>
       User will be prompted for input, from menu that is shown, enter option 1
This will configure federation server based on the configuration parameters given in config file.
Heterogeneous Federation Automation for Oracle and MSSQL Server:

(Common steps for VMware and PowerVM Capacity Planner)
Prerequisites
1. IBM InfoSphere Federation server 9.7/10.1
2. Database Client software for corresponding database (Oracle or MSSQL Server) installed on Capacity planner database server.

Configuring heterogeneous federation

IBM InfoSphere Federation Server allows federation of databases such that you can run a database query that can work with objects (for example, tables, views, and so on.) from different relational database systems, and such query is called as Federated Query.

You can create a federated system by first installing the federated engine, and then configuring the federated engine to communicate with the data sources.

There are the following basic federated objects:

A. The federated server that communicates with the data sources by means of software modules that are called as wrappers.
B. Each data source must be identified to the system as a server.
C. If the data sources require authentication, the remote authentication information can be registered with the federated system as user mappings.
D. Remote data sets that you want to access as nicknames to the federated system.
   You can reference the nickname in your application as a local table.

Before you begin

E. Install IBM InfoSphere Federation Server, version 10.1. You can use an existing copy of a compatible DB2 Version 10.1 database system or allow the IBM InfoSphere Federation Server installation wizard to install a new copy of the bundled DB2 Enterprise Server Edition 10.1. IBM InfoSphere Federation Server requires DB2 Database for the Linux, UNIX, and Windows operating systems.
F. You must install, configure, and test the client software for each federated data source that you want to access before you install the wrappers if the data source client software is required. The ODBC driver must be installed and configured on the federated server.

Note: It is assumed that the Capacity Planner database was created using the same instance owner. The instance owner on the Linux and UNIX operating systems is “db2inst1”; and on the Windows operating system, the instance owner is “db2admin”. Failures might be observed if you attempt to complete
these steps as a user with non-compliant authorization levels.

Install Capacity Planner for PowerVM application and Capacity Planner for PowerVM Database using IIM.

1. For MSSQL Server
   1. Registering service/node using database client software
      On Windows
         1. Set ODBC Connections.
         2. Note: Ensure that ODBC connections are already set on SQL Server Machine.
         3. Open ‘ODBC Data Source Administrator’ (Administrative Tools->Data Source(ODBC))
         4. Go to ‘System DSN ‘ tab
         5. Click on ‘Add’, Select ‘SQL Server’ from the list and click Finish
         6. Specify Data source ‘Name’ and SQL Server IP/Hostname, Click Next.(Data source name should be same as on SQL Server Machine)
         7. Note: Data source name must not have spaces or special characters in it.
         8. Select ‘With SQL Server authentication using login id and password entered by user’ option and check ‘Connection to SQL Server to obtain default settings for the additional options’.
         9. Enter Login id and password of SQL Server user. , click Next.
         10. Click Finish and test the connection.
      On Unix
         ● Install and Configure Data Direct ODBC drivers
         ● After you install the ODBC driver, configure the system information file, which is usually named odbc.ini.
            E.g.
            [ODBC Data Sources]
            WAREHOUS=MS SQL Server 2000
            [WAREHOUS]
            Driver=/opt/odbc/lib/ddmsss20.so
            Description=MS SQL Server Driver for AIX
            Address=9.112.98.123,1433
         ● Edit db2dj.ini file and set following environment variables in it
            ● ODBCINI – path to odbc.ini file
            e.g ODBCINI=/opt/IBM/odbcdriver/branded_odbc/IBM_Tools/odbc.ini
            ● DJX_ODBC_LIBRARY_PATH
              e.g DJX_ODBC_LIBRARY_PATH = /opt/IBM/odbcdriver/branded_odbc/lib/
         ● Stop and start DB2
            db2stop;
            db2start;
2. Registering federation server definition and adding links for all required TDW tables.
   - After registering service using client software, open command prompt.
   - Copy the AnalyticsDatabaseInstaller folder from the installed location to a temporary directory, eg. C:\temp on windows or /temp on non-windows.
     Example installed location on windows:
     C:\Program Files\IBM\JazzSM\installedDashboards\com.ibm.tivoli.cppowervm\AnalyticsDatabaseInstaller
     Example installed location on non-windows:
     /opt/IBM/JazzSM/InstalledDashboards/com.ibm.tivoli.cppowervm/AnalyticsDatabaseInstaller
     Note: The temporary directory should not have space in the name.
   - Change the working directory to directory where federation scripts (fed_admin.sh/bat) files are copied. For PowerVM, federation scripts are in federation_power directory. For Vmware, federation scripts are kept in “federation” directory.

1. Edit fed_config.cfg file in same directory and set following properties to appropriate values.
   - NODE_ID - the node name configured in odbc.ini file or data source name configured above.
   - TDW_REMOTE_HOST_NAME – IP address or complete host name of database server where TDW is installed.
   - TDW_REMOTE_DB_NAME – Name of remote TDW database
   - CP_DB_NAME - Name of capacity planner database. (e.g TADFDCCDB)
   - CP_DB_SCHEMA_NAME – Schema name in Capacity planner database (For PowerVM it is TADFDCCP)
   - FED_SERVER_NAME – name of federation server that is to be configured. This can be any unique name without special characters and space characters in it. This federation server will be used while federating TDW tables/views.
   - FED_DB_SERVER_TYPE – set this to MSSQL for MSSQL server data source
   - FED_DB_VERSION – set this to version on MSSQL Server (e.g. 2000 or 2008 etc.)
   - CP_DB_INSTANCE_OWNER – Instance owner of capacity planner database. This is the same user which was used to create capacity planner database.
   - CP_DB_INSTANCE_OWNER_PASSWORD – Password of capacity planner database instance owner. Required to connect to capacity planner database.
   - TDW_REMOTE_DB_INSTANCE_OWNER – Instance owner of remote TDW database. (default is ITMUSER). This is the user who created TDW database on remote TDW database server.
- **TDW_REMOTE_DB_INSTANCE_OWNER_PASSWORD** – Password of remote TDW database instance owner. Required while registering federation server definition.
- After updating `fed_config.cfg`, run `fed_adm.sh/bat` from same directory with appropriate argument. Refer to `Readme_federation.txt` for more details on command line parameters.
  - e.g `fed_adm.sh $JAVA_HOME -f fed_config.cfg`
2. For Oracle
   1. Registering service using database client software.
      On Windows
      1. Run “Net Manager” from oracle client software.
      2. In “net manager” UI right click on service naming. Click on new
      3. In new service naming panel enter name of service which will be
         used to connect to remote TDW name. Note that service name
         should not contain spaces or special characters. Click Next
      4. Select TCP/IP from protocol list and click next
5. In protocol settings window enter host name or IP Address of database server on which TDW on oracle database is installed. Also enter port number (Default is 1521) in port number input box.

6. In service window enter TDW database name in service name input box. Select “Database Default” in Connection Type drop down list.
7. In Test window click on test button. Provide user name i.e name of user used to connect to TDW on Oracle database and password. Test the service connection. Save settings and exit.

On Unix

- The Oracle client software must be installed and configured on the server where Capacity Planner database is installed.
- After you install client software and IBM federation server is installed, edit tnsnames.ora file with detail of TDW database connection

E.g.
```
tdw_node =
  (DESCRIPTION =
```

(ADDRESS_LIST =
(ADDRESS = (PROTOCOL = TCP)(HOST = ip_address)(PORT = 1521))
(CONNECT_DATA = (SERVICE_NAME = warehous)))

- Edit db2dj.ini file and set following environment variables in it
  - `ORACLE_HOME` – path to oracle client software installation directory
    - e.g. `ORACLE_HOME=\usr\oracle\8.1.7`
  - Set `TNS_ADMIN` environment variable to path where tnsnames.ora file is kept.
    - e.g. `TNS_ADMIN=$ORACLE_HOME/NETWORK/ADMIN`
  - Set `DB2LIBPATH` environment variable to `ORACLE_HOME/lib` folder
    - e.g. `DB2LIBPATH=$ORACLE_HOME/lib`

- Modify the `.bash_profile` of user `db2inst1` to add the following environment variables.
  - `ORACLE_HOME=<path to oracle client software installation directory>`
  - `export ORACLE_HOME`
  - `DB2LIBPATH=<ORACLE_HOME>/lib`
  - `export DB2LIBPATH`
  - `export PATH=<ORACLE_HOME>/bin:$PATH`
  - `LD_LIBRARY_PATH=<ORACLE_HOME>/lib:$LD_LIBRARY_PATH`
  - `export LD_LIBRARY_PATH`

- Stop and start DB2

2.2 Registering federation server definition and adding links for all required TDW tables.
- After registering service using client software, open command prompt.
- Change working directory to directory where federation scripts (fed_admin.sh/bat) files are kept. For PowerVM, federation scripts are in federation_power directory. For Vmware, federation scripts are kept in “federation” directory.
- Edit `fed_config.cfg` file in same directory and set following properties to appropriate values.
- **NODE_ID** - the node name configured in tnsnames.ora file on unix OR net service name which is configured using net8 manager on windows.
- **TDW_REMOTE_HOST_NAME** – IP address or complete host name of database server where TDW is installed.
- **TDW_REMOTE_DB_NAME** – Name of remote TDW database
- **CP_DB_NAME** - Name of capacity planner database. (e.g TADFDCDB)
- **CP_DB_SCHEMA_NAME** – Schema name in Capacity planner database (For PowerVM it is TADFDCP)
- **FED_SERVER_NAME** – name of federation server that is to be configured. This can be any unique name without special characters and space characters in it. This federation server will be used while federating TDW tables/views.
- **FED_DB_SERVER_TYPE** – set this to Oracle for Oracle server data source
- **FED_DB_VERSION** – set this to version of Oracle Server (e.g. 10, 11). This value has to be numerical value.
- **CP_DB_INSTANCE_OWNER** – Instance owner of capacity planner database. This is the same user which was used to create capacity planner database.
- **CP_DB_INSTANCE_OWNER_PASSWORD** – Password of capacity planner database instance owner. Required to connect to capacity planner database.
- **TDW_REMOTE_DB_INSTANCE_OWNER** – Instance owner of remote TDW database. (default is ITMUSER). This is the user who created TDW database on remote TDW database server.
- **TDW_REMOTE_DB_INSTANCE_OWNER_PASSWORD** – Password of remote TDW database instance owner. Required while registering federation server definition.

**On windows**
- Run fed_amdin.sh/bat from same directory with appropriate argument. Refer to Readme_federation.txt for more details on command line parameters.
  - e.g C:federation_power> fed_admin.bat $JAVA_HOME -f fed_config.cfg

**On Unix**
- open command prompt
- connect to capacity planner database.
  - e.g $>db2 "connect to TADFDCDB"
- Register wrapper by executing “create wrapper” command.
  - e.g $>db2 create wrapper net8
- Create server by executing “create server” command.
  - $> db2 “CREATE SERVER WHSERVER TYPE oracle VERSION 11 WRAPPER NET8 OPTIONS (NODE 'TDW_NODE') ”
Create user mapping by executing “create user mapping” command.
$> CREATE USER MAPPING FOR local_user SERVER server_name OPTIONS (REMOTE_AUTHID 'tdw_userID',
REMOTE_PASSWORD 'tdw_password')

- on command prompt run fed_amdin.sh from same directory with -i option. This executes federation script in interactive mode.
  e.g $> fed_admin.sh $JAVA_HOME -f fed_config.cfg -i
- Select option 3 “Add links” to add views. When prompted for name of link enter “all” and hit enter. This will federate all TDW tables to capacity planner database.

3. For DB2
   2. Registering federation server definition and adding links for all required TDW tables.

- Login to database server on which capacity planner database is installed as user which is used to create capacity planner database.
- Change working directory to directory where federation scripts (fed_admin.sh/bat) files are kept. For PowerVM, federation scripts are in federation_power directory. For Vmware, federation scripts are kept in “federation” directory.
  - **Note**: On windows Copy the AnalyticsDatabaseInstaller directory from the installed location to a temporary directory. For example, C:\temp.

Installed location on windows: C:\Program Files\IBM\JazzSM\installedDashboards\com.ibm.tivoli.cpdash\AnalyticsDatabaseInstaller. Temporary directory must not have space characters in path.
- Edit fed_config.cfg file in same directory and set following properties to appropriate values.
  - NODE_ID - the node name which can be used to create DB2 node on database server. This NODE_ID must not be more than 8 characters and must not contains special characters.
  - TDW_REMOTE_HOST_NAME – IP address or complete host name of database server where TDW is installed.
  - TDW_REMOTE_PORT – Port number of DB2 database server on which TDW is installed.
  - TDW_REMOTE_DB_NAME – Name of remote TDW database
  - TDW_LOCAL_ALIAS – Alias name which is used to catalog remote TDW database on local DB2 database server.
  - CP_DB_NAME - Name of capacity planner database. (e.g TADFDCDB)
  - CP_DB_SCHEMA_NAME – Schema name in Capacity planner database (For PowerVM it is TADFDCP. For Vmware schema name is TADFDC).
- FED_SERVER_NAME – name of federation server that is to be configured. This can be any unique name without special characters and space characters in it. This federation server will be used while federating TDW tables/views.
- FED_DB_SERVER_TYPE – set this to DB2/CS for DB2 server data source
- FED_DB_VERSION – set this to version of DB2 Server (e.g. 10.1, 9.7 etc.). This value has to be numerical value.
- CP_DB_INSTANCE_OWNER – Instance owner of capacity planner database. This is the same user which was used to create capacity planner database.
- CP_DB_INSTANCE_OWNER_PASSWORD – Password of capacity planner database instance owner. Required to connect to capacity planner database.
- TDW_REMOTE_DB_INSTANCE_OWNER – Instance owner of remote TDW database. (default is ITMUSER). This is the user who created TDW database on remote TDW database server.
- TDW_REMOTE_DB_INSTANCE_OWNER_PASSWORD – Password of remote TDW database instance owner. Required while registering federation server definition.
- USE_EXISTING_CATALOGED_TDW – This must be set to yes if user has manually created alias for remote TDW database and wants to use it for federation. If catalog is not created then federation script will attempt to create an alias for remote TDW using the value provided for TDW_LOCAL_ALIAS property. Set this to NO if user doesn't want to use existing alias to be used in federation.

- Note : Set USE_EXISTING_CATALOGED_TDW to NO only if you are sure that no alias is present on capacity planner database with the name provided for property TDW_LOCAL_ALIAS. Otherwise scripts might remove such alias after it fails to register federation server.
- After updating fed_config.cfg, run fed_amdin.sh/bat from same directory with appropriate argument. Refer to Readme_federation.txt for more details on command line parameters.
  - On Unix
    - e.g fed_admin.sh $JAVA_HOME -f fed_config.cfg
  - On Windows
    - e.g fed_admin.bat %JAVA_HOME% -f fed_config.cfg
13.0 Notices

This information was developed for products and services offered in the United States. IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

Trademarks and service marks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at "Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.
Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of others.